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1.0 Introduction 

Thank you for choosing WipWare’s WipFrag/MailFrag Service; an economical and rapid 
method of collecting bulk material size and shape information. 
 
This user’s manual will cover: 
 

• What is WipFrag/MailFrag Service? 
• Developing a sampling strategy 
• Collecting quality image samples 
• Analyzing images using WipFrag 
• How to submit a MailFrag study 
• Interpreting particle size data 
• Frequently Asked Questions 
• Pricing and service terms 

1.1 Notice 

The collection of image samples in today’s productivity driven industrial environments can 
be challenging, however, there is no reason that it cannot be done safely.  

Caution: Working near unconsolidated material can be dangerous as it may shift or settle 
without warning. 

 

Warning: Observe site specific rules and regulations at all times. 

 

1.2 Disclaimer 

The information contained herein is based on experience and is believed to be accurate and 
up to date as of the date of its preparation. However, uses and conditions of use are not 
within the manufacturer’s control and users should determine the suitability of such 
products and methods of use for their purposes. Neither the manufacturer nor the seller 
makes any warranty of any kind, express or implied, statutory or otherwise, except that the 
products described herein shall conform to the manufacturer’s or seller’s specifications. 
The manufacturer and the seller expressly disclaim all other warranties, INCLUDING, 
WITHOUT LIMITATION, WARRANTIES CONCERNING MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE. Under no circumstances shall the manufacturer or the seller 
be liable for indirect, special, consequential, or incidental damages including, without 
limitation, damages for lost or anticipated profits. 
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2.0 What is WipFrag / MailFrag Service? 

WipWare’s WipFrag software allows you to open and analyze your own images.  
WipWare’s proprietary edge detection is used to render a polygon network around each 
particle to instantly generate fragmentation results. 
 
WipWare’s MailFrag Service allows you to send your images to us for analysis by our 
trained experts using WipFrag.  We will analyze the images and send back the 
fragmentation results within 2 business days. 

2.1 Outputs Received 

WipFrag 

Every analysis you perform is saved to a CSV file.  You can also save the charts and merged 
results as PDF, BMP, JPG, EMF or WMF.  Using WipFrag, you can merge any number of 
results in any way you wish. 

MailFrag Service 

Each image or set of images are submitted as a study.  Each study includes a: 

• PDF for optimal printing quality 
• BMP image for easy embedding in documents or presentations 
• CSV that can be viewed in any spreadsheet application.   

 
If a study contains more than one image, the PDF and BMP will be a graphical output of the 
merged results, and the CSV will contain the individual image results as well as the final 
merged result. 

2.2 WipFrag Process 

Below is a simple overview of the WipFrag process: 

1. Open an image. 
2. Set the scale. 
3. Generate the edges. 
4. Generate the results. 

2.3 MailFrag Process 

Below is a simple overview of the MailFrag Service process: 

1. Register an account (free of charge). 
2. Login to MailFrag Service gateway. 
3. Purchase image analysis credits. 
4. Submit study details and upload images. 
5. Allow up to 2 business days for results to be made available. 
6. Login to MailFrag Service gateway and view results. 
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3.0 Developing a Sampling Strategy 

It is critical to develop a good sampling strategy prior to undertaking any scientific study; 
failure to do so may compromise your project’s validity. The purpose of developing a 
strategy is to create a set of systematic and unbiased rules that will be followed for the 
duration of the study, if these rules are properly developed you will avoid the frustration of 
an inconclusive study result. 

Both WipFrag and MailFrag service are capable of analyzing any number of image samples; 
if you image each particle in the material, the analysis would be 100 percent 
representative. Since that is not practical for most applications we need to develop a 
method of systematically acquiring smaller samples that represent the characteristics of 
the material as a whole. 

3.1 Sampling Methods 

All sampling strategies should aim to control as many variables as possible; however we 
sometimes need to make concessions at the expense of data quality. When selecting the 
sampling team personnel, special care must be taken to ensure availability to execute the 
sampling method you select (day/night/cross-shift/weekend etc…); ideally each of these 
“sample collectors” must also train and use the same equipment in the same way (same 
camera, lens, zoom, lighting, scale, perspective, exposure, resolution etc…) to achieve the 
best results. 

When trying to determine which method is suitable you will need to ask yourself: 

• What percentage of the material do I need to be statistically valid? 
• What percentage of the material does each image sample contain? 
• Are material characteristics expected to change throughout the sample? 
• How important are the decisions you will be making based on the results? 

There are many different ways to sample. It is often important to record the sampling 
methodology for future reference, possibly to defend the results; the balance between 
representativeness versus ease of sample collection must be determined. 

Simple Random Sampling: 

Simple random sampling involves the use of an eligible randomizer to generate the 
sampling parameters. This method is very good as long as it eliminates human bias. 

EXAMPLE:  rolling dice to determine how many samples will be taken each day and at what 
time. 

Systematic Sampling: 

Systematic sampling involves a strict time interval sampling regardless of circumstance. 
With reasonable frequency this method is typically superior to all other sampling methods 
as it is by definition systematic. 

EXAMPLE:  collecting one sample every X minutes. 
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Stratified Sampling: 

If there are multiple versions of the material in similar volume then stratified sampling may 
be suitable. Stratified sampling involves taking equal number of random samples from each 
version of the material. This method is good if all versions of the material have similar 
volumetric proportions relative to the whole, otherwise it is a poor selection as it may 
overrepresent the smaller population and underrepresent the larger. 

EXAMPLE: collecting a random but equal number of samples from each version of the 
material. 

Probability Proportional to Size Sampling: 

If there are multiple versions of the material in dissimilar volume then probability 
proportional to size sampling may be suitable. Probability proportional to size involves 
taking proportion corrected number of random samples from each version of the material. 
This method is good if the volumetric proportions can be accurately estimated; otherwise 
over/underestimation may occur. 

EXAMPLE:  collecting a random but proportion corrected number of samples from each 
version of the material. 

Cluster Sampling: 

Cluster sampling involves collecting multiple samples at specific time intervals. This 
method can be good if it is executed properly but has a significant probability of missing 
important material variation. 

EXAMPLE: collecting X number of samples each day at X time. 

Quota Sampling: 

Quota sampling is considered non-probability sampling which involves the collection of a 
predetermined number of samples from select versions of the material. This method is 
generally not recommended for the purpose of material sampling because it is non-random 
and has a significant probability of missing important material variation. 

EXAMPLE: collecting X number of samples from version A and Y number of samples from 
version B regardless of volumetric proportion. 

Accidental Sampling: 

Accidental, convenience or grab sampling is considered non-probability sampling which 
involves the collection of a sample whenever it is convenient. This is by far the most 
common and least desirable; it is non-random, non-systematic and has the highest 
probability of missing important material variation. 

EXAMPLE: collecting a sample whenever it is convenient. 
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4.0 Collecting Quality Image Samples 

The more you can establish standards and reduce variables the more consistent your 
images will be. The better your images are, the better your results. 
 
Operators - The fewer personnel taking pictures the better, to avoid personal biases 
affecting sample procedure.   
 

“Some photographers will be drawn to the largest particles; others will select areas 
of uniform distribution,” wrote Norbert Maerz in ‘Image Sampling Techniques and 
Requirements for Automated Image Analysis of Rock Fragmentation’ (1996). 

 

Equipment - Use the same camera and lens where feasible. 

Physical Setup - Camera position, camera height, and camera-to-subject distance should 
be standardized as much as possible. 

Lighting - Use consistent lighting: Lighting geometry, light to subject distance, light height, 
lighting angle (relative to camera position) and lighting orientation (aiming). 

Camera Settings – Try to standardize Aperture, Shutter, ISO, White Balance, Capture size & 
quality. 

Sample Selection - Work in a systematic manner to capture statistically representative 
samples. Large drifts, or those containing primarily small particles, should be 
photographed in grid-like segments. 

5.0 Equipment 

5.1 Camera 

Point & Shoot  

Compact digital cameras can yield good images above ground in good lighting. Because the 
small image sensors in these cameras are inefficient at gathering photons in low-light 
situations, their performance drops off dramatically in the conditions common to 
underground photography. As ISO sensitivity is increased to compensate for low-light 
levels, the signal-to-noise ratio rises significantly, limiting the usefulness of the resulting 
images for photographic fragmentation analysis. 
  



Sampling and Analysis Guide  WipWare 

Page 10 

D-SLR 

D-SLR cameras, with their larger sensors, are far more efficient at gathering photons in 
low-light situations, making them better suited to underground photography.   

Cameras with 18 megapixel and even higher resolution sensors are common now, but the 
full-resolution files these cameras produce are far in excess of what is required for 
fragmentation photoanalysis. Choosing a smaller capture size will result in smaller files 
that analyze much faster. 

2.5 MP capture – 1900 x 1300 pixels – 7MB file size 

5MP capture – 2500 x 1800 pixels – 12.9MB file size 

18MP capture – 5100 x 3500 pixels – 51.1MB file size 

5.2 Lens 

Understand that with many D-SLR cameras, the image sensor is smaller than traditional 
35mm film, meaning that a ‘crop factor’ must be taken into account when discussing lenses.  
Typically, this crop factor is between 1.3x and 2x (consult your camera documentation to 
determine the factor for your particular camera body). The crop factor increases the 
effective focal length of all your lenses. For example, a 35mm lens on a body with a crop 
factor of 1.6 (typical of most non-pro Canon D-SLRs), would effectively become a 56mm 
lens (35 x 1.6 = 56). 

Crop factors –  
Canon Professional bodies – 1x to 1.3x 
Canon Consumer bodies – 1.6x 
Nikon Professional bodies – 1x to 1.5x 
Nikon Consumer bodies – 1.5x 
Olympus bodies – 2x 
Pentax bodies – 1.5x 

Avoid effective focal lengths smaller than 40mm for fragmentation analysis purposes. 
Effective focal lengths of 40mm-135mm are best. 

Try to standardize camera-to-subject distance and focal length for more consistent results. 

5.3 Filter  

In the hostile conditions often encountered while capturing images for fragmentation 
analysis, it’s a good idea to protect the front element of your lens from dust, moisture, 
scratches. 

Use high-quality clear protective filters such as: B&W MRC (Multi-Resistant Coating), Hoya 
Pro 1 HMC (Hoya Multi-Coating), or Nikon NC (Neutral Colour). 

Protective filters should be removed if shooting through glass or shooting a backlit scene to 
avoid loss of contrast and/or flare. 
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5.4 Tripod or Support 

Using a tripod helps ensure sharp, consistent images and helps improve composition and 
framing.  Tripods also permit the use of shutter speeds that might result in camera shake if 
hand-held, as well as permit the use of small aperture settings to increase depth-of-field. 

5.5 Lighting 

A pair of standard work lights on tall stands is a low-cost, readily available solution. 

6.0 Camera Configuration & Settings 

6.1 File Format 

JPEG: The JPEG file format produces compressed files that occupy minimal disc space. Care 
needs to be taken to avoid overcompression, both in-camera and during post-processing. 
Avoid making changes and saving a JPEG file multiple times. With each ‘save’ operation, the 
file is recompressed and detail can suffer.       

6.2 Capture Size 

Set capture size in camera rather than downsize using image processing software 
(Photoshop, etc.).  Less than 1.5MP provides insufficient detail – especially dependent on 
coverage area and material sizes.  More than 5.0MP is excessive (slows software) and may 
require resampling, which if not done correctly can introduce artifacts. 

6.3 Capture Quality 

This refers to the compression setting that is used when creating JPEG files in-camera. 
Use the least amount of compression possible with your camera. Manufacturers use 
varying terminology to describe this feature such as; Good/Better/Best, or 
Normal/Fine/Superfine, or Smooth/Stepped. In each case the underlined term is the 
preferred setting to use. 

6.4 White Balance 

Not overly critical for this application. Auto White Balance can be used, or if using halogen 
work lamps, set white balance to Tungsten (Incandescent). 
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6.5 Focal Length 

Choice of focal length can affect analysis results. Wide-angle lenses with effective focal 
lengths below 35mm should not be used due to perspective error; foreshortening between 
foreground and background will skew results. Corner and edge distortion inherent to wide 
angle optics will produce sizing inaccuracies. Using wide-angle optics also complicates light 
placement. 

For muck piles, use the longest focal length that is practical in any given situation. Placing 
the camera further away from the pile and zooming in to fill the viewfinder with muck will 
yield the best results. 

Below is a comparison of identically sized coffee mugs shot with telephoto (Figure 3-1) and 
wide-angle (Figure 3-2) to illustrate perspective distortion. 

  

Figure 3-1: Telephoto Figure 3-2: Wide-Angle 

6.6 Point of View (Camera location) 

 

If possible, elevate the camera position and orient the camera back parallel to the face of 
the muck pile. This approach will yield the best perspective on the pile and result in images 
that are more representative of the actual material being analyzed.  
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6.7 Composition 

Fill your viewfinder with rock particles and avoid capturing surrounding areas such as 
tunnel roof, floor or walls underground, or areas of sky in outdoor images. 

Below is an example of a composition that is too loose, which includes irrelevant areas 
(Figure 3-3) and one where the photographer has filled the viewfinder entirely with 
relevant material (Figure 3-4). 

  

Figure 3-3: Wasted Area Figure 3-4: Filled Area 

6.8 Exposure Mode & Settings 

Correct exposure yields an image that is not too light, not too dark.  Three variables are 
Shutter Speed, Aperture, and ISO.  

Shutter Speed 

If not using a tripod or other support, you need a shutter speed fast enough to avoid 
camera shake. The hand-holding threshold will vary depending on effective focal length 
setting of lens.  To determine the hand-holding threshold in any given situation: 

1. Determine effective focal length:  Multiply focal length (as indicated on lens barrel) by 
your camera’s crop factor, typically 1X to 2X depending on camera model. 

2. Create a fraction using the effective focal length as the denominator.  
3. The shutter speed closest to this fraction is the hand-holding threshold for this 

situation. 
4. Do not use shutter speeds slower than the result of Step 3. 

EXAMPLE:  lens set to 50mm on a 1.5X body… 

1. 50mm X 1.5 = 75mm (Effective Focal Length) 
2. 1/75 
3. Set shutter speed to 1/80 sec or faster. 

NOTE: Some lenses are available featuring Vibration Reduction or Image Stabilization. These 
lenses can extend the hand-holding threshold by varying amounts. You should conduct tests to 
determine how this feature performs in specific applications with your equipment before 
deviating from the above formula. 
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Below illustrates the comparison between a sharply-focused image (Figure 3-5) with one 
suffering from directional unsharpness caused by camera movement during exposure 
(Figure 3-6). 

  

Figure 3-5: Sharply Focused Figure 3-6: Motion Blurred 

 
Aperture 

You need to use an aperture setting that ensures adequate depth-of-field. This will vary 
depending on camera-to-subject distance, focal length setting and depth of material to be 
photographed. 

Setting will typically be f8 or smaller (f11, f16 etc.). Aperture settings larger than f5.6 (f4, 
f2.8 etc.) may not provide sufficient depth-of-field to hold all particles in sharp focus. 

Use Aperture Priority mode and set aperture to f8. Make note of the shutter speed the 
camera chooses and determine if it is fast enough to prevent camera shake.  If not, you need 
to use camera support or adjust ISO upwards. 

Images below illustrate the effect of the aperture setting on depth-of-field, where a wide 
aperture setting of f3.5 allows only the point-of-focus to remain sharp (Figure 3-7), while a 
small aperture setting of f11 produces a deeper field of sharp focus (Figure 3-8). 

  

Figure 3-7: Wide Aperture (f3.5) Figure 3-8: Small Aperture (f11) 
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ISO 

You should use the lowest ISO setting that is adequate in any given situation. Noise 
increases with higher ISO settings.  If, after setting the aperture, your shutter speed is too 
slow to hand-hold, adjust ISO setting upwards until shutter speed meets or exceeds the 
hand-holding threshold.  If ISO cannot be raised high enough to permit a safe hand-holding 
shutter speed, you must use camera support (tripod, etc.). 

Below is an image shot with a low ISO setting of 100 (Figure 3-9) and one shot with a very 
high ISO setting of 12,800 (Figure 3-10).  Note the appearance of grain-like noise 
throughout the image with the high ISO setting (Figure 3-10). 

  

Figure 3-9: Low ISO (100) Figure 3-10: Very High ISO (12,800) 
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7.0 Lighting 

7.1 Considerations 

There are three primary considerations for lighting – Intensity, Uniformity and Contrast. 

Intensity 

Intensity is important only if hand-holding the camera. Intensity must be sufficient to 
permit a fast enough shutter speed to overcome camera movement during exposure which 
will cause loss of sharpness. Using a tripod is one of the best ways to improve both capture 
sharpness and ensure segmented coverage of a large pile. 

Uniformity 

If a large area is lit with a single light there will be a falloff of intensity towards the edges 
compared to the center. Falloff can also occur between the front and back of a muckpile. If 
exposure is based on the intensity of illumination in the center/front of the field (as it 
should), material at the edges/back may be underexposed, hampering analysis.   

The farther a light source is located from the subject, the more even its illumination will be. 
When lights are used in close proximity to the material, intensity may vary considerably, 
with objects farther from the light source receiving significantly less illumination. 

Images below illustrate the comparison between an image where light falls with even 
intensity on both rocks and the background (Figure 4-1) and an image where the light 
source is moved closer to the subject (Figure 4-2), causing objects located at varying 
distances from the source to receive significantly different intensities of illumination. 

  

Figure 4-1: Distant Light Source Figure 4-2: Near Light Source 
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Contrast 

Photographic fragmentation analysis is dependent on contrast between rock particles and 
the shadows between the particles. If contrast is too high, surface texture of individual 
particles may result in the software interpreting them as multiple smaller blocks. If 
contrast is too low, shadows between blocks may be absent and the software may 
misinterpret small particles as larger single blocks. 

Excessively high contrast is common when using artificial light underground or low-angled 
sunlight above ground. Avoid use of on-axis artificial light which tends to throw shadows 
behind the particles creating low contrast conditions. Similarly, when working above 
ground, heavily overcast skies can produce low contrast images. 

  

Figure 4-3: High Contrast Figure 4-4: Low Contrast 

 

Figure 4-5: Normal Contrast 

7.2 Shadows 

Lighting is arguably one of the most important factors for photographs destined for 
fragmentation analysis software. Lighting determines shadow formation. In an ideal image, 
particles are clearly delineated by soft shadows. 

If shadows are too strong (dark), analysis suffers. This is typical of images taken with a 
single off-camera light. Shadows will fall to one side of the material, and in the absence of 
fill light may be dark enough to obscure material or may be mistaken for particles. 

If shadows are absent, analysis suffers. This is typical of on-axis light such as the camera’s 
built-in flash, where the shadows fall behind the material and are hidden from view. 
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7.3 Lighting Gear 

The light source that many new users attempt to employ is on-camera flash, whether the 
camera’s built-in flash or a hot-shoe mounted accessory flash. Unfortunately, when the light 
is coming from the camera position, the shadows are cast BEHIND the subject. Form and 
texture are obscured. Think in terms of the difference between an on-camera flash lit 
picture of a friend and a professionally-lit portrait. In the first example, there are no 
shadows and the subject looks ‘flat’, while in the second, controlled shadows bring three-
dimensional modeling to the face. 

Ideal lighting is difficult to achieve underground without use of supplementary lights. 

A pair of 500W or greater single-head halogen work lights on stands is inexpensive, 
portable and effective. Look for units with support stands that go as high as possible. The 
more common dual-head units can produce multiple shadows that may affect analysis. 
Remove the protective cage as it will affect even illumination. 

If low-power lights are used or powerful lights are used at considerable distance, the 
resulting shutter speeds may require camera support. 

Long-life, energy-efficient LED work lights are available but tend to be more expensive to 
purchase. 
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7.4 Light Placement 

 

• Position lights equal distances to left and right of camera position and as far apart as 
possible. 

• Position lights as high as possible. 
• Aim light on right towards left edge of drift (approx. 45 degrees from lens axis). 
• Aim light on left towards right edge of drift (approx. 45 degrees from lens axis). 
• Crossing the lights in this manner will produce the most even illumination, reducing 

’hot-spots’. 
• If lighting angle is less than 15 degrees from lens axis, shadow formation will be less 

than ideal. 
• If lights are positioned too close to the muckpile, the resulting fall-off in intensity 

will mean that particles near the back of the pile receive significantly less 
illumination than the front of the pile. As light-to-subject distance increases falloff is 
reduced. 
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Lighting Placement Diagram 

For example, let’s say you want to capture a 15-foot wide drift in a single image. If you’re 
using a D-SLR with a crop factor of 1.6 and a lens set to 35mm (effectively 56mm), the 
camera would need to be positioned approx. 30 feet from the front of the drift in order to 
fit the drift in the frame from edge-to-edge. 

In this scenario your lights should be no closer than 15 feet from the front of the drift (45-
degrees). Farther is better. Even with lights placed at 15ft, the back of the pile will receive 
one f-stop less light than the front. By metering the center of the drift, acceptable images 
should be obtained. With lights placed at 30 feet (15-degrees), there would be no difference 
whatsoever in brightness between front and back of the drift. Intensity will be reduced 
however, producing less light on the muckpile and requiring longer shutter speeds. 
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Special Considerations 

Wet (reflective) material – specular highlight formation may affect analysis accuracy. 
Diffusing the light will produce larger, more even highlights. Complete elimination of 
specular highlights on reflective material requires use of polarized lighting sources in 
combination with a polarizing filter on the camera lens and is likely too complex for most 
users.  
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8.0 Analyzing Images in WipFrag 

If you own WipFrag you can analyze your images samples yourself.  If you do not own 
WipFrag you can take advantage of our MailFrag Service.  A typical WipFrag operation will 
consist of the following: 
 

1.  Open an image file. 
 

2.  Set the scale for the image. 
 

3.  Activate the automatic Edge Detection Algorithms.  
 

4.  
Use the Editing tools to improve the edge detection. 

 

5.  Do a virtual Sieve, to measure block sizes and generate a graph. 
6. Repeat steps 1 – 5 for all image samples. 
7. To merge the results, select the arrow beside the ‘Open File’ icon and select ‘Merge 

Frag Files’. 

  
8. Browse to where the .frag files are saved, highlight each that you wish to merge and 

click ‘Open’. 
9. You should now be presented with the merged results as a chart. 

a. The data for this chart is also saved into the specified logfile. 
10. If you wish to save the graph, select:  ‘File > Save As’. 

 
 
 
Note:  For more information about the WipFrag process, please see the WipFrag User’s 
Manual that is distributed with the software.  
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9.0 Submitting a MailFrag Study 

To submit a set of images, which we call a study, you will first need to login to WipWare’s 
MailFrag Service gateway located at http://wipware.com/products-services/mailfrag/.  If 
you do not have an account, you can create one free of charge.   
 
The following will take you through the full process of creating an account, logging in for 
the first time, buying image analysis credits, submitting a study, waiting for the results, 
viewing the results and viewing the options menu. 
 

9.1 Creating an Account 

To create a free MailFrag Service gateway 
account you will need to click on the ‘Request 
Account’ link located below the sign in form. 
 
 
 
 
 
 
 

After completely filling out the registration 
form, you will be emailed a verification link.  
Clicking on the verification link will confirm 
you are the creator and will activate your 
account immediately. 
  

http://wipware.com/products-services/mailfrag/
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9.2 Logging In 

 
 
 
 

Once your account has been created and verified you will be able to login.  After logging in, 
your home page will be shown which displays your analysis list (if any).  You can return to 
this page at any time by clicking on the MailFrag icon or the home button. 
 

9.3 Help 

Selecting the ‘Help’ menu 
will display a YouTube 
video tutorial as well as a 
link to download this 
manual.  
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9.4 Purchasing Image Analysis Credits 

1. Select the shopping cart. 

2. Select the number of image 
analysis credits you require. 

3. Remit payment using 
PayPal. 

4. Login to your PayPal 
account or ‘Buy as a Guest’. 

a. You do not require a PayPal 
account.  You can purchase 
credits as a guest using any 
major credit card. 

5. Select ‘Pay Now’ to proceed 
to WipWare’s final order 
confirmation. 

a. The order will not be 
completed until the end of 
the next step. 

6. If the order details are 
correct, select ‘Submit’ to 
complete the payment. 

a. If you are a Canadian 
customer, you will now see 
the HST added to the order. 

7. Once your purchase 
transaction is complete, an 
invoice will be displayed and 
emailed to you.  

8. You are now ready to 
submit a study. 
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9.5 Submitting a Study 

A study requires a title, scale information, size classes, image samples and special 
instructions, if any.  To add a study, follow the instructions below: 

 
1. Click the ‘Add Study’ icon. 

2. Enter a suitable title.  The 
title should describe the origin 
of the image samples. 

3. Add the scale information.  
The scale reference can be any 
dimensionally stable object of 
known size.  For example, an 
H.I. stick or a laser scale with a 
known length.   

a. It is necessary to include the 
units of measurement. 

4. Select the output size 
classes.  For your convenience, 
there are two presets:  ISO 
(Metric) and Standard 
(Imperial).  If, however, you 
prefer custom user definable 
size classes you can select 
‘Custom’ then enter up to 27 
custom sizes.   

a. It is necessary to include the 
units of measurement. 

 

 

 

5. Add the image samples.  You can either drag and drop images onto the control or select 
‘Add Files’.   

a. You should only add as many images as you have credits.   

b. If you add more images than you have credits, the study will be temporarily put on hold until 
a positive balance is achieved.   

c. If you need to remove any images you can select the red delete button. 

6. Once you have added all of the image samples, you must select ‘Start upload’. 

7. Enter any special instructions for the study, if any. 

8. After agreeing to the terms of service, you may submit the study and immediately 
receive an order confirmation (see next page). 
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Note: 
 
1. Please allow up to 2 business days for WipWare to complete the analysis and make the 

results available. 
 

2. WipWare reserves the right to reject unsuitable images. 
 

3. Each study includes a PDF for optimal printing quality, a BMP image for easy embedding in 
documents and presentations, and a CSV that can be viewed in any spreadsheet 
application. 
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9.6 Waiting for Results 

 
 
 
 
 
 

On the home page, you will see a list of pending studies.  From left to right, you will see: 
 

1. The study title. 
2. The number of images in the study. 
3. The date the study was submitted. 
4. The status of the study. 

a. The clock indicates that the analysis is in progress. 
 

 
Clicking on the study’s title 
will show you to the 
previously submitted study 
details.   
 
Please note that you cannot 
alter the study parameters 
once they have been 
submitted. 
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9.7 Viewing the Results 

 
 
When a study is complete and the results are made available, you will receive an email.  On 
the MailFrag Service gateway home page, you will see a list of completed studies.  From left 
to right, you will see: 
 

1. The study title. 
2. The number of images in the study. 
3. The date the study was submitted. 
4. The status of the study. 

a. The checkmark indicates that the analysis is complete.  
 

5. CSV, BMP and PDF icons that can be clicked to directly download the results. 
 

Clicking on the study’s title 
will show you to the 
previously submitted study 
details.   
 
From here you will see a 
preview of the analysis 
results as well as additional 
icons to download the CSV, 
BMP and PDF. 
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9.8 Options 

 

 

Account Info 
Selecting the ‘Options’ menu 
will first bring you to the 
screen where your account 
information will be displayed.  
This information cannot be 
directly edited.  If you need to 
make any changes to this 
information please contact 
WipWare Technical Services. 
 

 

 

 

 

Order History 
Selecting ‘Order History’ will 
show a list of order 
transactions.  If you require the 
details of an invoice, clicking 
on the invoice number will 
display a printable version of 
the invoice. 
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Activity 
Selecting ‘Activity’ will show 
you a one year graph of your 
account usage.  
 

The blue bar displays the 
number of studies submitted.  
Hovering over the bar will also 
display the total number of 
images that were submitted. 
 

The green bar displays the 
total number of credits that 
were purchased, transferred in 
and transferred out.  If the total 
is a negative number, this bar 
will instead be red. 

 

 

Transfer Images 
Selecting ‘Transfer Images’ will 
allow you to transfer image 
analysis credits to another 
MailFrag user.  This will allow 
large volume purchases to be 
shared amongst team 
members.  Please note that 
credit transfers cannot be 
undone. 
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9.9 Known Issues and Solutions 

 
I cannot create an account.  It always says ‘The security code entered was incorrect’. 
 
I created an account but I cannot remain logged in.  When I navigate to a different 
page I am asked to log in again.  
 
These are most likely due to Internet Explorer not having cookies/sessions and JavaScript 
enabled.  If possible, we recommend Chrome or Firefox as they work out of the box.  
However, if you must use Internet Explorer you can do the following: 

 
1. Select ‘Tools > Internet options’. 

a. ‘Alt-T’ brings up the tools menu. 

2. Select the ‘Security’ tab. 

3. Select ‘Internet’ and then hit the 
‘Custom level…’ button. 

4. Scroll down to ‘Script > Active 
scripting’ and select ‘Enable’. 

5. Hit OK. 

6. Select the ‘Privacy’ tab. 

7. Select the ‘Medium’ setting. 

8. Hit Apply/OK.  
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10.0 Interpreting Particle Size Data 

The particle size distribution (PSD) of material is critical in understanding its physical and 
chemical properties. It affects the strength and load-bearing properties of rocks and soils. It 
affects the reactivity of solids participating in chemical reactions, is necessary to determine 
material density, and needs to be tightly controlled in many industrial applications. 

10.1 Particle Size Distribution Types 

Particle Size Distributions are typically expressed in one of four ways: 
• Cumulative percent passing curve 
• Cumulative percent retained curve 
• Data Table 
• Histogram 
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Three of these are usually represented in log-normal graphical plots since the size 
distribution range will often traverse many orders of magnitude between the smallest and 
largest particle which would be difficult to illustrate in normal graphical space. 
Generally there is a preference by discipline, e.g. Metallurgists generally prefer the 
cumulative percent passing curves as it may be easier to find typical KPI values that are 
critical to the process, such as D80 (Diameter of 80% of the material), whereas blast 
designers generally prefer the histogram because it is easier to see non-standard particle 
size distributions which can be indicative of a blasting malfunction. 

10.2 Particle Size Distribution Parameters 

There are many parameters that can be used to describe points in a PSD; these include 
Min/Max/Mean/Median/Mode Particle Size, any number of 0-100% Passing or up to 27 
user definable size fractions. Access to this data is made simple via CSV files that any 
spreadsheet application can open, if you have not already captured the real time particle 
size telemetry into a plant/process historian.  Below is an example of the CSV contents. 
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10.3 Particle Size Distribution Formulas 

Most PSD’s can also be described using a formula of best fit.  For this purpose there are 
dozens of models, however, WipWare currently supports two; Rossin Rammler and the 
Swebrec methods. Rossin Rammler is based on two parameters, Xc and n, each of which 
could be used as a KPI. For example, Xc is known as the characteristic size of the 
distribution and is more specifically D63.2 (63.2% of the material is X size or less) which is 
a very useful and versatile number to work with. The n value is a measure of uniformity. 
For example, marbles that have very little variation in size will have a very high n value 
such as 10+ whereas ultra-wide particle size distributions, such as blast results, can yield 
particles the size of cars down to dust and will have a much smaller uniformity of < 0.75. 
 

 
 

n=3.0 
Characterized by a very uniform 
size distribution, where the 
smallest common visible block is 
about 1/3 the size of the largest 
common block.  
 
(Scale = 1”) 
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n=2.0 
Characterized by a fairly uniform 
size distribution, where the 
smallest common visible block is 
about 1/5 the size of the largest 
common block. The ratio of the 
number of largest common blocks 
to smallest common blocks is about 
20:1. 
 
(Scale = 1”) 
 

 
n=1.5 
Characterized by a moderately 
poorly uniform size distribution, 
where the smallest visible common 
block is about 1/8 the size of the 
largest common block.  The ratio of 
the number of the largest common 
blocks to smallest common blocks 
is about 8:1.  Small areas of 
particles that are too small to be 
resolved cover about 5% of the 
image. 
 
(Scale = 1”) 
 

 
n=1.25 
Characterized by a poorly uniform 
size distribution, where the 
smallest common visible block is 
about 1/12 the size of the largest 
common block. The ratio of the 
number of largest common blocks 
to smallest common blocks is about 
2:1. Areas of particles that are too 
small to be resolved cover about 
15% of the image.  
 
(Scale = 1”) 
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n=1.0 
Characterized by a moderately well 
graded size distribution, where the 
smallest common visible block is 
about 1/16 the size of the largest 
common block.  The ratio of the 
number of largest common blocks 
to smallest common blocks is 
about 1:2.  Areas of particles that 
are too small to be resolved cover 
about 30% of the image.  
 
(Scale = 1”) 
 

 
n=0.75 
Characterized by a well graded size 
distribution, where the smallest 
common visible block is about 1/18 
the size of the largest common 
block.  The ratio of largest common 
blocks to smallest common blocks 
is about 1:8.  Areas of particles that 
are too small to be resolved cover 
about 40% of the image.  
 
(Scale = 1”) 
 

 
n=0.5 
Characterized by a very well graded 
size distribution, where the 
smallest common visible block is 
about 1/20 the size of the largest 
common block. The ratio of largest 
common blocks to smallest 
common visible blocks is about 
1:15. Areas of particles that are too 
small to be resolved cover over 
50% of the image.  
 
(Scale = 1”) 
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10.4 Study Planning and Execution 

When undertaking a formal study it is important to first understand the data, how it is 
collected and what it represents. Once suitable KPI’s are determined, a suitable base line 
must be established prior to inducing changes to the process; this helps avoid 
misinterpreting relative change for noise. Moving forward, strict adherence to the pre-
established systematic sampling methodology is critical; this minimizes the possibility of 
your study becoming invalid or inconclusive. 

If you require assistance establishing a study strategy or interpreting the resulting data 
WipWare can connect you with approved consultants, specialists and even third party 
software to assist with continuous improvement efforts.  Contact WipWare Technical 
Services for details. 

Publishing a technical paper? We are interested in technical papers that apply WipWare 
technology; if you are currently planning, working on or have already published a technical 
paper that involves our systems particle size/shape telemetry we would like to hear about 
it. A reward for best paper is awarded annually! 
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11.0 Frequently Asked Questions 

This section of the guide answers the three most common questions new users have when 
starting a study using WipFrag or a MailFrag Service campaign. 
 

11.1 Are high resolution image samples better? 

Large and small image samples each have their benefits and disadvantages. WipWare 
recommends taking 1.2 to 5.0 MegaPixel image samples depending on the particle sizes 
being analyzed. To help decide what resolution is best for your application take note of the 
following: 
 

• Higher resolution images are large, sometimes difficult to handle files that are less 
effective at detecting oversize and more effective at detecting fines 

• Lower resolution images are small, usually easy to handle files that are more 
effective at detecting oversize and less effective at detecting fines 

• If you cannot outline the particles of interest visually, neither can our technology 
• It is always possible to reduce the image resolution 

 

11.2 What is a suitable scale device? 

Every image to be analyzed must include a scale device in the image sample. When 
selecting a suitable scale device it is important that all of the following points are checked: 
 

• Scale device should contrast well against the material being analyzed 
• Scale device should be at least 1/10th of the image sample width (more is better) 
• Scale device must be dimensionally stable (avoid inflatable objects) 
• Scale device must be placed perpendicular to the camera view 
• If acquiring image samples perpendicular to the material surface is not possible, 

multiple scale devices may be necessary for tilt correction 
 

11.3 How many image samples should I take? 

The short answer to this question is as many as possible; the practical answer to this 
question is different for each user and better determined by your goal. The questions you 
need to ask yourself are: 
 

• What percentage of the material do I need to be statistically valid? 
• What percentage of the material does each image sample contain? 
• How important are the decisions you will be making based on the results? 
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12.0 Pricing and Service Terms 
Contact SSASS:
Tel: +27 12 880 0145
Email: info@ssass.co.za

There are no additional charges associated with: 

• MailFrag Account creation
• Transfer of image analysis credit
• Minimum order quantity
• Monthly or annual fees

Terms of Service: 

• WipWare reserves the right to reject unsuitable image samples
• Please allow up to 2 business days for analysis results to be available
• Each analysis study includes one of each CSV, BMP and PDF type outputs
• WipWare reserves the right to change products, services and specifications


